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  Introduction
Introduction
Cisco Unified Presence collects information about user availability, such as whether users are using 
communications devices (for example, a phone) at a particular time. Cisco Unified Presence can also 
collect information about individual user communications capabilities, such as whether web 
collaboration or video conferencing is enabled. Applications such as Cisco Jabber and Cisco Unified 
Communications Manager use this information to improve productivity amongst employees, that is, to 
help employees connect with colleagues more efficiently and determine the most effective way for 
collaborative communication.

These release notes describe new features, requirements, restrictions, and caveats for Cisco Unified 
Presence Release 8.6(x). These release notes are updated for every maintenance release but not for 
patches or hot fixes. 

Before you install Cisco Unified Presence, Cisco recommends that you review the “Related 
Documentation” section on page 13 for information about the documentation available for 
Cisco Unified Presence.

Note • Cisco Unified Presence Release 8.6(3)a supports an export unrestricted (XU) version only. The 
unrestricted version differs from previous releases of Cisco Unified Presence in that it does not 
contain strong encryption capabilities.

• Be aware that after you install an unrestricted release, you can never upgrade to a restricted version. 
In addition, you cannot perform a fresh install of a restricted version on a system that contains an 
unrestricted version. 

System Requirements
• Hardware Server Requirements, page 2

• Server Software Requirements, page 3

• Supported Browsers, page 4

Hardware Server Requirements
The Cisco Unified Presence system is a software product that is loaded onto a hardware server. The 
hardware server must meet the following requirements:

• One of the following server models:

Cisco 7800 Series Media Convergence Server (MCS) listed in the Hardware and Software 
Compatibility Information for Cisco Unified Presence. Go to Cisco.com for the latest 
information:
http://www.cisco.com/en/US/products/ps6837/products_device_support_tables_list.html
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  System Requirements
Note Cisco Unified Presence does not support MCS-xxxx-I1-IPC1 or MCS-xxxx-H1-IPC1 servers. 
However, a bridged upgrade is available to customers who need to migrate from any of the 
discontinued hardware, except for the following servers: MCS-7825-H1-IPC1, 
MCS-7825-I2-IPC1, MCS-7825-I1-IPC1, MCS-7825-I2-IPC2. For details about the 
unsupported hardware and the bridged upgrade, see the Upgrade Guide for Cisco Unified 
Presence Release 8.6 here:
http://www.cisco.com/en/US/products/ps6837/prod_installation_guides_list.html

– Cisco-approved, customer-provided third-party server that is the exact equivalent of one of the 
supported Cisco MCS servers. Go to http://www.cisco.com/go/swonly.

– Cisco Unified Computing System B-series blades or Cisco Unified Computing System C-series 
rackmount servers. For information about these Cisco Unified Computing System servers, see 
the Hardware and Software Compatibility Information for Cisco Unified Presence Release 8.x 
here:
http://www.cisco.com/en/US/products/ps6837/products_device_support_tables_list.html 

• DVD-ROM drive

• Keyboard, mouse, and monitor

Note Additional server requirements, such as port and IP address requirements, are described in 
Port Usage Information for Cisco Unified Presence.

The Cisco Unified Presence installer checks for the presence of the DVD-ROM drive, sufficient hard 
drive and memory sizes, and sufficient CPU type and speed.

Cisco Unified Presence supports bridged upgrades from any of the following servers:

• MCS-7825-H2-IPC1

• MCS-7825-H2-IPC2

• MCS-7835-H1-IPC1

• MCS-7835-I1-IPC1

• MCS-7845-H1-IPC1

• MCS-7845-I1-IPC1

The bridged upgrade allows you to create a DRS backup on the discontinued hardware. You can then 
restore the DRS backup on supported hardware after you complete a fresh Cisco Unified Presence 
installation on the supported hardware. If you attempt an upgrade on discontinued hardware, Cisco 
Unified Presence displays a warning on the interface and on the CLI, informing you that Cisco Unified 
Presence only supports the functionality to create a DRS backup on this server.

Server Software Requirements
The Cisco Unified Presence server runs on the Cisco Linux-based operating system. This operating 
system is included with the application.

Related Topic

Installation and Upgrade Notes, page 6
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  System Requirements
Supported Browsers
Use Microsoft Internet Explorer version 6.0 or a later release, or Mozilla Firefox version 3.0 or a later 
release, to access these interfaces: Cisco Unified Presence Administration, Cisco Unified Serviceability, 
and Cisco Unified Communications Operating System Administration. 

Note Cisco Unified Presence does not currently support Safari or Google Chrome on the Mac OS or Microsoft 
Windows.

How to Use Hypertext Transfer Protocol over Secure Sockets Layer (HTTPS)

Hypertext Transfer Protocol over Secure Sockets Layer (SSL), which secures communication between 
the browser client and the Apache Tomcat web server, uses a certificate and a public key to encrypt the 
data that is transferred over the Internet. HTTPS, which ensures the identity of the server, supports 
applications, such as Cisco Unified Serviceability. HTTPS also ensures that the user sign-in password is 
transported securely via the web.

HTTPS for Internet Explorer

The first time you (or a user) access Cisco Unified Presence Administration or other Cisco Unified 
Presence SSL-enabled virtual directories after a Cisco Unified Presence installation or upgrade, a 
Security Alert dialog box asks whether you trust the server. When the dialog box displays, you must 
respond in one of the following ways:

• By selecting Yes, you select to trust the certificate for the current web session only. If you trust the 
certificate for the current session only, the Security Alert dialog box displays each time that you 
access the application: that is, until you install the certificate in the trusted folder.

• By selecting View Certificate > Install Certificate, you indicate that you intend to perform certificate 
installation tasks, so you always trust the certificate. If you install the certificate in the trusted folder, 
the Security Alert dialog box does not display every time you access the web application.

• By selecting No, you cancel the action. No authorization occurs, and you cannot access the web 
application. To access the web application, you must select Yes or install the certificate via the View 
Certificate > Install Certificate option.

Note The system issues the certificate using the hostname. If you attempt to access a web application using 
the IP address, the Security Alert dialog box displays, even though you installed the certificate on the 
client.

Saving the Certificate to the Trusted Folder

You can save the CA Root certificate in the trusted folder, so the Security Alert dialog box does not 
display each time that you access the web application.

Step 1 Perform the required steps depending on the Internet browser you are using:
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  System Requirements
Table 1 Saving the Certificate to the Trusted Folder

If you are 
Using...... Actions Troubleshooting Tips

Internet 
Explorer 6 and 
8

a. Browse to the application on the Tomcat web server.

b. Select View Certificate when the Security Alert 
dialog box displays.

c. Select Install Certificate in the General pane of the 
Certificate dialog box.

d. Select Next in the Certificate Import Wizard dialog 
box.

a. Select Place all certificates in the following store.

b. Select Browse adjacent to the Certificate store field.

c. Browse to Trusted Root Certification Authorities.

d. Select OK.

e. Select Next.

f. Select Finish.

g. Select Yes to install the certificate.

h. Select OK after you receive a message stating that 
the import was successful.

i. Select OK in the lower, right corner of the Certificate 
dialog box.

j. Select Yes to trust the certificate, so you do not 
receive the dialog box again.

• After you save the certificate to the trusted 
folder in Internet Explorer, the next time you 
browse to the server, ensure that you enter the 
fully qualified domain name (FQDN) of the 
server that is associated with the certificate.

• You can verify that the certificate was 
installed successfully by selecting the 
Certificate Path tab in the Certificate pane.
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  Installation and Upgrade Notes
Installation and Upgrade Notes
• New System Installation, page 7

• System Upgrade, page 7

• The Latest Software Upgrades for Cisco Unified Presence on Cisco.com, page 9

Internet 
Explorer 7

a. Browse to the application on the Tomcat web server.

b. Select Continue to this website (not 
recommended) option to access the server.

c. Select View Certificate when the Security Alert 
dialog box displays.

d. Select Install Certificate in the General pane of the 
Certificate dialog box.

e. Select Next in the Certificate Import Wizard dialog 
box.

f. Select Automatically select the certificate store 
based on the type of certificate.

g. Browse Next.

h. Select Finish.

i. Select Yes in the Security Warning dialog box.

j. Select OK in the Certificate Import Wizard dialog 
box.

• After you save the certificate to the trusted 
folder in Internet Explorer, the next time you 
browse to the server, ensure that you enter the 
FQDN of the server that is associated with the 
certificate.

• To verify that the trust store contains the 
imported certificate, select Tools > Internet 
Options in the Internet Explorer toolbar and 
select the Contents tab. Select Certificates 
and select the Trusted Root Certifications 
Authorities tab. Scroll to find the imported 
certificate in the list.

• After importing the certificate, the browser 
continues to display the address bar and a 
Certificate Error status in red. The status 
persists even if you re-enter the hostname or 
IP address or refresh or relaunch the browser.

• You can verify that the certificate was 
installed successfully by selecting the 
Certification Path tab in the Certificate pane.

Netscape a. Browse to the application using Netscape.

b. Select one of the following radio buttons:

• Accept this certificate for this session

• Do not accept this certificate and do not connect

• Accept this certificate forever (until it expires)

• Select OK in the Certificate Authority dialog box.

• Select OK in the Security Warning dialog box

• After you save the certificate to the trusted 
folder in Netscape, the next time you browse 
to the server, ensure that you enter the FQDN 
name of the server that is associated with the 
certificate.

• If you select Do not accept this certificate 
and do not connect, the application does not 
open.

• To view the certificate credentials before 
installing the certificate, select Examine 
Certificate.

Table 1 Saving the Certificate to the Trusted Folder (continued)

If you are 
Using...... Actions Troubleshooting Tips
6
Release Notes for Cisco Unified Presence Releases 8.6(1), 8.6(2), 8.6(3), and 8.6(3)a



 

  Installation and Upgrade Notes
New System Installation
For new installations, you must order the Cisco Unified Presence system software and adhere to 
licensing requirements. To order the software, go to http://www.cisco.com/en/US/ordering/index.shtml 
or contact your Cisco sales representative.

Each Cisco Unified Presence shipment comes with an installation DVD, which is required for all new 
installations of Cisco Unified Presence, for example, Cisco Unified Presence Release 8.6. The 
Cisco Unified Presence operating system and application software is installed from the installation 
DVD. For example, for new installations of the Cisco Unified Presence Release 8.6(3) software, use the 
DVD that indicates Cisco Unified Presence Release 8.6(3).

Related Topic

Software Licensing Requirements for VMware, page 11

System Upgrade

Caution If you fresh install the unrestricted version of Cisco Unified Presence Release 8.6(3)a, you will not be 
able to later perform a fresh install of the restricted version of this software.

• Supported Upgrade Paths to Cisco Unified Presence Release 8.6(x), page 7

• Upgrade from Cisco.com, page 8

Supported Upgrade Paths to Cisco Unified Presence Release 8.6(x)

Cisco Unified Presence supports the following software upgrade paths to Release 8.6(x):
7
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  Installation and Upgrade Notes
Table 2 Supported Upgrade Paths

Note Direct upgrades from Cisco Unified Presence Release 6.0(x) to Release 8.6(x) are not supported. You 
must first upgrade to Release 7.0(x) of Cisco Unified Presence. For more information about upgrading 
to Cisco Unified Presence Release 7.0(x), see the Release Notes for Cisco Unified Presence Release 
7.0(x) here on Cisco.com: 
http://www.cisco.com/en/US/products/ps6837/prod_release_notes_list.html.

Upgrade from Cisco.com

Cisco does not support downloading major Cisco Unified Presence software releases from Cisco.com, 
for example, Cisco Unified Presence Release 8.0. From Cisco.com you can download upgrade-only 
software images that are used to upgrade from a previous major software release to a subsequent 
software maintenance release or point release of Cisco Unified Presence. For example, you can 
download Cisco Unified Presence Release 8.0(2) or Cisco Unified Presence Release 8.6(2) from 
Cisco.com.

To download this software, go to 
http://tools.cisco.com/support/downloads/go/Redirect.x?mdfid=278875240. You must have an account 
on Cisco.com to access the Software Center. The images posted at the Software Center require existing 
installations of Cisco Unified Presence.

Related Topics

• Supported Upgrade Paths to Cisco Unified Presence Release 8.6(x), page 7

Supported Upgrade Paths from 
Cisco Unified Presence... Installation Instructions

Release 7.0(x), 8.0(x), or 8.5(x) 
to 8.6(x)

Upgrades from Release 7.0(x), 8.0(x), or 8.5(x) to Release 8.6(x) 
require the UCSInstall_CUP_*.sgn.iso file. 

Perform these steps to proceed with the upgrade:

1. Go to http://www.cisco.com/upgrade.

2. Enter your software contract number.

3. Select the CUP<pre-upgrade release>-8-6-U-K9= option to 
order. If you do not see this option, contact your Cisco Account 
Team and/or Reseller to resolve your Contract issue.

4. Go to http://www.cisco.com/cisco/software/navigator.html.

5. Navigate to Products > Voice and Unified Communications > 
Unified Communications Applications > Cisco Unified 
Presence > Cisco Unified Presence 8.6 > Unified Presence 
Server Updates.

6. Download the complete ISO file: 
UCSInstall_CUP_8.6.x.10000-x.sgn.iso

7. Install the “Installation and Upgrade (7.0(x) to 8.6(x))”, 
“Installation and Upgrade (8.0(x) to 8.6(x))” or “Installation 
and Upgrade (8.5(x) to 8.6(x))” upgrade DVD that Cisco 
provides.
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  Installation and Upgrade Notes
• The Latest Software Upgrades for Cisco Unified Presence on Cisco.com, page 9

The Latest Software Upgrades for Cisco Unified Presence on Cisco.com

Before You Begin

You can only download point releases of Cisco Unified Presence software from Cisco.com.

• Accessing the Upgrade File for Cisco Unified Presence Release 8.5(x) to 8.6(1), page 9

• Accessing the Upgrade File for Cisco Unified Presence Release 8.5(x) to 8.6(2), page 9

• Accessing the Upgrade File for Cisco Unified Presence Release 8.5(x) to 8.6(3), page 10

• Accessing the Upgrade File for Cisco Unified Presence Release 8.5(x) to 8.6(3)a, page 10

Accessing the Upgrade File for Cisco Unified Presence Release 8.5(x) to 8.6(1)

Perform the following steps to access the upgrade file.

Before You Begin

You can only download point releases of Cisco Unified Presence software from Cisco.com.

Procedure

Step 1 Download the UCSInstall files from Cisco Connection Online.

Step 2 Use an md5sum utility to verify that the MD5 sum of the final file is correct:

3bc43f2644b4e4d438751c744509558b UCSInstall_CUP_8.6.1.10000-34.sgn.iso

Troubleshooting Tips

You can upgrade the ISO image onto a remote server as an alternative to using the upgrade DVD. Copy 
the ISO (UCSInstall_CUP_8.6.1.10000-34.sgn.iso) to your FTP or SFTP server.

Related Topics

• New System Installation, page 7

• Upgrade from Cisco.com, page 8

Accessing the Upgrade File for Cisco Unified Presence Release 8.5(x) to 8.6(2)

Perform the following steps to access the upgrade file.

Before You Begin

You can only download point releases of Cisco Unified Presence software from Cisco.com.

Procedure

Step 1 Download the UCSInstall files from Cisco Connection Online.

Step 2 Use an md5sum utility to verify that the MD5 sum of the final file is correct:
9
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  Installation and Upgrade Notes
0c4a74c7ce8164c2408b42174d924d13 UCSInstall_CUP_8.6.2.10000-44.sgn.iso

Troubleshooting Tips

You can upgrade the ISO image onto a remote server as an alternative to using the upgrade DVD. Copy 
the ISO (UCSInstall_CUP_8.6.2.10000-44.sgn.iso) to your FTP or SFTP server.

Related Topics

• New System Installation, page 7

• Upgrade from Cisco.com, page 8

Accessing the Upgrade File for Cisco Unified Presence Release 8.5(x) to 8.6(3)

Perform the following steps to access the upgrade file.

Before You Begin

You can only download point releases of Cisco Unified Presence software from Cisco.com.

Procedure

Step 1 Download the UCSInstall files from Cisco Connection Online.

Step 2 Use an md5sum utility to verify that the MD5 sum of the final file is correct:

86bf9bd71b9fff36526da1aaa31474df UCSInstall_CUP_8.6.3.10000-20.sgn.iso

Troubleshooting Tips

You can upgrade the ISO image onto a remote server as an alternative to using the upgrade DVD. Copy 
the ISO (UCSInstall_CUP_8.6.3.10000-20.sgn.iso) to your FTP or SFTP server.

Related Topics

• New System Installation, page 7

• Upgrade from Cisco.com, page 8

Accessing the Upgrade File for Cisco Unified Presence Release 8.5(x) to 8.6(3)a

Perform the following steps to access the upgrade file.

Before You Begin

You can only download point releases of Cisco Unified Presence software from Cisco.com.

Procedure

Step 1 Download the UCSInstall files from Cisco Connection Online.

Step 2 Use an md5sum utility to verify that the MD5 sum of the final file is correct:
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  Additional Installation and Upgrade Considerations
eb76c36840384ee7124670250ffd2aff UCSInstall_CUP_UNRST_8.6.3.10000-23.sgn.iso

Troubleshooting Tips

You can upgrade the ISO image onto a remote server as an alternative to using the upgrade DVD. Copy 
the ISO (UCSInstall_CUP_UNRST_8.6.3.10000-23.sgn.iso) to your FTP or SFTP server.

Related Topics

• New System Installation, page 7

• Upgrade from Cisco.com, page 8

Additional Installation and Upgrade Considerations
• Perform Cisco Unified Presence 8.6(x) Upgrade Before Cisco Unified Communications Manager 

8.6(x) Upgrade, page 11

• Software Licensing Requirements for Release 7.0(x) to 8.6(x) Upgrades, page 11

• Software Licensing Requirements for VMware, page 11

• Recommendations for Release 8.0(x) or 8.5(x) to 8.6(x) Upgrades, page 12

• Recommendations for Release 7.0(x) to 8.6(x) Intercluster Upgrades, page 12

Perform Cisco Unified Presence 8.6(x) Upgrade Before Cisco Unified 
Communications Manager 8.6(x) Upgrade

You must perform the Cisco Unified Presence Release 8.6(x) upgrade before you perform the 
Cisco Unified Communications Manager Release 8.6(x) upgrade. Cisco does not support Cisco Unified 
Presence 8.0(x) servers running with Cisco Unified Communications Manager Release 8.5 or 8.6.

Software Licensing Requirements for Release 7.0(x) to 8.6(x) Upgrades
If you upgrade from Release 7.0(x) to Release 8.6(x), you require a new software version license for each 
Cisco Unified Presence server in your deployment. You must order a separate software version license 
for each Cisco Unified Presence server. However, you need to upload the license to the first node in a 
cluster. For information about Cisco Unified Presence licensing modes and requirements, see the 
Installation Guide for Cisco Unified Presence Release 8.6 here: 

http://www.cisco.com/en/US/products/ps6837/prod_installation_guides_list.html

Software Licensing Requirements for VMware
You can run this release of Cisco Unified Presence on a VMware virtual machine deployed on approved 
Cisco Unified Computing server hardware. For information about supported servers, see Hardware and 
Software Compatibility Information for Cisco Unified Presence Release 8.x. For information about the 
VMware licensing requirements, see the License Activation for Cisco UC on UCS Docwiki here: 
http://docwiki.cisco.com/wiki/License_Activation_for_Cisco_UC_on_UCS
11
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  Additional Installation and Upgrade Considerations
Recommendations for Release 8.0(x) or 8.5(x) to 8.6(x) Upgrades
Before you upgrade from Cisco Unified Presence Release 8.0(x) or 8.5(x) to Release 8.6(x), we strongly 
advise that you follow the recommended upgrade procedure in the Upgrade Guide for Cisco Unified 
Presence Release 8.6 here: 
http://www.cisco.com/en/US/products/ps6837/prod_installation_guides_list.html 

Important Notes

• Cisco Unified Presence Sync Agent Service—prior to performing an upgrade, this service may be 
disabled on the cluster (which only runs on the Publisher node). This will ensure that user-initiated 
changes from the corresponding Cisco Unified Communications Manager system during the 
upgrade, do not compromise the upgrade process. The changes will be reconciled when the Cisco 
Unified Presence Sync Agent is restarted in either the current or newer version.

• Publisher node—switch versions and restart the publisher node prior to initiating a switch version 
and restart on the Subscriber nodes. If the Cisco Unified Presence Administration GUI is operational 
on the Publisher node, it is safe to initiate a switch version and restart on the Subscriber node. 

Note Services on the Publisher will not start until the Subscribers are switched, restarted, and replication is 
successfully established on that cluster.

• High Availability User Support—Cisco Unified Presence Release 8.6(x) supports up to 15,000 users 
per cluster in a High Availability (HA) configuration and up to 30,000 users per cluster in a non-HA 
configuration. If, when you upgrade, you are left with a number of unsupported users, we 
recommend that you unlicense these surplus users on Cisco Unified Communications Manager 
before you perform the upgrade.

• Contact List Size—the default maximum value is 200; however you can configure this to a higher 
value, or configure 0 to set it to unlimited value. After you perform the upgrade, check that the 
contact list size for users has not reached the maximum value. If you have a large number of contacts 
per user, the number of users that a Cisco Unified Presence node supports is reduced. 

Recommendations for Release 7.0(x) to 8.6(x) Intercluster Upgrades
Before you perform an intercluster upgrade from Release 7.0(x) to Release 8.6(x), we strongly 
recommend that you follow the intercluster upgrade procedure described in the intercluster chapter of 
the Upgrade Guide for Cisco Unified Presence Release 8.6.

Important Notes

• Cisco Unified Presence Sync Agent Service—prior to performing an upgrade, this service may be 
disabled on the cluster (which only runs on the Publisher node). This will ensure that user-initiated 
changes from the corresponding Cisco Unified Communications Manager system during the 
upgrade, do not compromise the upgrade process. The changes will be reconciled when the Cisco 
Unified Presence Sync Agent is restarted in either the current or newer version.

• Presence Engine (PE)—prior to performing the software upgrade, turn off (deactivate) the Cisco 
Unified Presence Presence Engine (PE) in the local Cisco Unified Presence cluster. If you intend to 
upgrade all clusters to Release 8.6(x), you must turn the Cisco Unified Presence PE on all clusters 
that are being upgraded until you complete the intercluster upgrade in your intercluster deployment.
12
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  Limitations and Restrictions
• CPU—you may experience high CPU (possibly for several hours) while the Cisco Unified Presence 
PE attempts to reestablish any presence subscriptions with remote clients. The potential for high 
CPU exists if a very large number of users are involved (for example, greater than10,000).

• Contact Size Limit—presence subscriptions to remote contacts will not work for users who have 
reached their contact list size limit on the local or remote cluster.

• SIP Remote Contact Limit—there is a limit to the number of SIP remote contacts that can be active 
at one time. This maximum value changes based on platform type (see the Deployment Guide for 
Cisco Unified Presence Release 8.6 for platform details). If you intend to leave an intercluster peer 
on Release 7.0(x), and you enable the Cisco Unified Presence XCP SIP federation service, you may 
exceed this limit depending on the number of remote contacts on the Release 8.6(1) peer clusters. If 
you exceed the limit, Cisco Unified Presence will not process the remaining contacts. For SIP 
subscription limits, see the SIP Remote Contact Limit in the Deployment Guide for Cisco Unified 
Presence Release 8.6 here:
http://www.cisco.com/en/US/products/ps6837/products_installation_and_configuration_guides_lis
t.html

Limitations and Restrictions
No caveats were closed in this release.

Related Documentation
The complete Cisco Unified Presence documentation set, with the latest information for Release 8.6(x), 
is now available here on Cisco.com.

http://www.cisco.com/en/US/products/ps6837/tsd_products_support_series_home.html

To search for documentation on any given release, we recommend that you use the Custom Google 
search capability introduced in the last release.

New and Changed Information
• About Cisco Unified Presence Release 8.6(1), page 13

• About Cisco Unified Presence Release 8.6(2), page 15

• About Cisco Unified Presence Release 8.6(3), page 16

• About Cisco Unified Presence Release 8.6(3)a, page 17

About Cisco Unified Presence Release 8.6(1)
The following sections describe new features and changes that are pertinent to Cisco Unified Presence 
Release 8.6(1). The sections may include configuration tips, information about users, and where to find 
more information.

• Copyright Information, page 14

• Partitioned Intradomain Federation with LCS/OCS, page 14

• BAT Enhancements, page 14
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  New and Changed Information
• Cross-Cluster Login Redirect, page 14

• Calendar Scale Specifications, page 15

• Support for VMware Deployments on Qualified IBM and HP Servers, page 15

• Support for ICSA High Availability, page 15

• Platform SOAP Service, page 15

For information about all available features and benefits, see the data sheet for Cisco Unified Presence 
at http://www.cisco.com/en/US/products/ps6837/products_data_sheets_list.html.

Copyright Information

Portions of this software product are governed by certain open source and third-party licenses. For more 
information and acknowledgments of copyright, see the Licensing Information for Cisco Unified 
Presence at 

http://www.cisco.com/en/US/products/ps6837/products_licensing_information_listing.html

Partitioned Intradomain Federation with LCS/OCS

The Partitioned Intradomain Federation feature allows Cisco Unified Presence and LCS/OCS 
deployments to co-exist within a single presence domain. Employees will be partitioned across both 
deployments, with an employee being either a licensed Cisco Unified Presence user or an LCS/OCS 
enabled user, but not both.

For more information about this feature, see the new Integration Guide for Configuring Partitioned 
Intradomain Federation for Cisco Unified Presence Release 8.6 and Microsoft LCS/OCS here:
http://www.cisco.com/en/US/products/ps6837/products_installation_and_configuration_guides_list.ht
ml

BAT Enhancements

Additional Bulk Administration Tool (BAT) functionality has been added to allow the importing of user 
contact lists into Cisco Unified Presence.

For more information, see the Deployment Guide for Cisco Unified Presence Release 8.6 here:
http://www.cisco.com/en/US/products/ps6837/products_installation_and_configuration_guides_list.ht
ml

Cross-Cluster Login Redirect

Prior to Cisco Unified Presence Release 8.6(1), only intracluster redirects were possible. Cisco Unified 
Presence Release 8.6(1) supports the ability to redirect intercluster users attempting to sign in over 
SOAP. This feature only applies to Cisco Unified Commuting clients and third-party clients who make 
use of SOAP interface on Cisco Unified Presence.

For more information about this feature, see the Deployment Guide for Cisco Unified Presence Release 
8.6 here:
http://www.cisco.com/en/US/products/ps6837/products_installation_and_configuration_guides_list.ht
ml.
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Calendar Scale Specifications

Cisco Unified Presence Release 8.6(1) supports 100% of users subscribing to calendar presence and 50% 
of users performing simultaneous calendar transitions. 

For information about how to enable calendar integration, see the Integration Guide for Configuring 
Cisco Unified Presence Release 8.5 and 8.6 with Microsoft Exchange here:
http://www.cisco.com/en/US/products/ps6837/products_installation_and_configuration_guides_list.ht
ml

Support for VMware Deployments on Qualified IBM and HP Servers

In addition to UCS B-Series and C-Series blade servers, Cisco Unified Presence Release 8.6(1) now 
supports VMware on IBM and HP servers. For more information, see 
http://docwiki.cisco.com/wiki/Unified_Communications_in_a_Virtualized_Environment

Support for ICSA High Availability

Prior to Cisco Unified Presence Release 8.6(1), the Intercluster Sync Agent (ICSA) was not High 
Availability (HA) aware. The ICSA carried out the syncing with intercluster peers on the publisher node 
only. When the publisher node experienced a failure, intercluster syncing of user information was 
broken. This feature introduces HA support on the subscriber node, therefore, when the ICSA on the 
publisher node experiences a failure, the HA-enabled ICSA on the subscriber node becomes active and 
takes over the syncing with IC peers. When the publisher node recovers, the subscriber ICSA switches 
back to run active on the publisher node. 

For more information about High Availability, see the Deployment Guide for Cisco Unified Presence 
Release 8.6 here: 
http://www.cisco.com/en/US/products/ps6837/products_installation_and_configuration_guides_list.ht
ml

Platform SOAP Service

The Platform SOAP service provides a web-based interface to facilitate your system upgrades and COP 
file installations of Cisco Unified Presence. This web-based interface also enables large scale 
deployments of Cisco Unified Presence to be initiated and monitored from a single management client. 
If you need to manage system upgrades, this service must be turned on for all Cisco Unified Presence 
nodes. For more information, see the Application Programming Interface (API) guide here 
http://developer.cisco.com/web/cupapi/docs.

About Cisco Unified Presence Release 8.6(2)
The following section describes an enhancement that is pertinent to Cisco Unified Presence Release 
8.6(2). The section may include configuration tips, information about users, and where to find more 
information.

Cisco Unified Presence and Instant Messaging Scalability, page 16
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  New and Changed Information
Cisco Unified Presence and Instant Messaging Scalability

In Cisco Unified Presence Release 8.6(2), Instant Messaging (IM) and Presence scalability has been 
increased. Two modes are supported: Unified Communications (UC)-only mode and Instant Messaging 
(IM)-only mode. 

UC-only mode includes presence and IM features as well as telephony presence integration from Cisco 
Unified Communications Manager, such as on-hook and off-hook status. This integration provides a rich 
presence in the network. IM-only mode only includes traffic relating to presence and IM. 

For scalability values, see Table 3 and Table 4.

About Cisco Unified Presence Release 8.6(3)
The following section describes new features and changes that are pertinent to Cisco Unified Presence 
Release 8.6(3). The section may include configuration tips, information about users, and where to find 
more information.

• Updating Client Type, page 16

• Tracking XMPP and Cisco Jabber 8.x Users, page 16

• Cisco Unified Personal Communicator Name Change, page 17

• Desk Phone Control Name Change, page 17

Updating Client Type

The Client Type option (Application > Client Type) has been added to the Cisco Unified Presence 
Administration interface to enable administrators to query users of specific client applications included 
with Cisco Unified Presence. The Client Type page can provide the type of client application and a 
description of the SOAP type corresponding to specific Cisco Unified Communications or third-party 
clients.

For more information, refer to the Online Help associated with the Client Type page.

Tracking XMPP and Cisco Jabber 8.x Users

The Cisco Unified Presence Administration interface now provides the ability to query licensed and 
unlicensed users that are logged into XMPP-based Cisco Unified Communications and third-party 
applications. The type of information that can be queried includes the following:

• users who have calendaring capability

• users who are assigned Microsoft Remote Call Control (RCC) capability

• licensed users of Cisco Unified Presence

• licensed users of Cisco Jabber

• all active or signed-in third-party XMPP clients

• all active or signed-in users of third-party APIs

• users at or exceeding the Maximum Contact List Size

• users at or exceeding the Maximum Watchers Limit

For more information, see the Online Help for the User Management > End User menu option.
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Cisco Unified Personal Communicator Name Change

All references to Cisco Unified Personal Communicator, general or specific to Release 8.x, have been 
changed to Cisco Jabber on the Cisco Unified Presence and Cisco Unified Communications Manager 
Administration graphical user interfaces. As such, all related Online Help topics and documentation 
guides have also been updated to reflect this change. For more information, see Documentation Updates, 
page 33.

Desk Phone Control Name Change

The Cisco Unified Presence Administration interface now uses the term Microsoft RCC (Remote Call 
Control) to refer to Desk Phone Control. Keep in mind that in terms of GUI, Online Help, and 
documentation changes are concerned, this name change applies only within the context of Microsoft 
Office Communicator; desk phone control on Cisco Jabber will continue to be referred to as Desk Phone 
Control. For more information about the Online Help topics and documentation guides that are affected 
by this name change, see Documentation Updates, page 33.

About Cisco Unified Presence Release 8.6(3)a

Export Unrestricted Cisco Unified Presence

Cisco Unified Presence Release 8.6(3)a supports an export unrestricted (XU) version. All versions of 
Cisco Unified Presence prior to Release 8.6(3)a are regarded as restricted. 

Note The unrestricted version of Cisco Unified Presence is a new version of software intended only for a very 
specific set of customers who do not want various security capabilities; the unrestricted version is not 
intended for general Cisco Unified Presence deployments.

Export unrestricted Cisco Unified Presence differs from restricted Cisco Unified Presence as follows:

• Encryption of user payload (information exchange) is not supported. 

• Administrators cannot send broadcast instant messages from the Cisco Unified Presence 
Administration GUI. 

• End users cannot send broadcast instant messages from the User Options interface. 

• External SIP interdomain federation with Microsoft OCS/Lync or AOL is not supported. 

• After you install an unrestricted release, you can never upgrade to a restricted version. A fresh install 
of a restricted version on a system that contains an unrestricted version is also not supported. 

You can perform a fresh install of an unrestricted version by downloading the following UCSInstall file: 
eb76c36840384ee7124670250ffd2aff UCSInstall_CUP_UNRST_8.6.3.10000-23.sgn.iso. For 
information about how to perform a fresh install, see the Installation Guide for Cisco Unified Presence 
here:
http://www.cisco.com/en/US/products/ps6837/prod_installation_guides_list.html

For all Graphical User Interfaces (GUIs) and Command Line Interfaces (CLIs), the Administrator can 
view the product version (restricted or export unrestricted). 
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  New and Changed Information
The following table describes the GUI items that are not available for the export unrestricted version of 
Cisco Unified Presence. 

Export Unrestricted GUI Item Location Description

Cisco Unified Presence Administration GUI

System > Application Listeners All TLS and HTTPS listeners have been removed. 

You cannot add TLS or HTTPS listeners. 

You cannot update a listener to a TLS or HTTPS 
listener. 

System > Security Settings You cannot check the Enable XMPP Client to 
CUP Secure Mode setting. 

You cannot check the Enable XMPP 
Router-to-Router Secure Mode setting.

You cannot check the Enable Web Client to CUP 
Secure Mode setting. 

The option to set SIP Intra-cluster Proxy-to-Proxy 
Transport Protocol to TLS has been removed. 

System > Security > TLS Context Configuration This menu item has been removed. 

System > Security > TLS Peer Subjects This menu item has been removed. 

System > Service Parameters - Cisco UP SIP 
Proxy service

All TLS options have been removed for the 
Transport Preferred Order parameter. 

The TLS option has been removed from the SIP 
Route Header Transport Type parameter. 

The Allow SIP-TLS Conversion to SIP parameter 
has been removed. 

The SIP TLS Session Timeout (seconds) 
parameter has been removed. 

Presence > Inter-clustering The option to set the protocol to TLS has been 
removed. 

Presence > Inter-domain Federation > SIP 
Federation

The option to configure an integration type of 
Inter-domain to AOL has been removed. 

When you configure interdomain federation to 
OCS/Lync, you will receive warning popup to 
indicate that it is only possible to directly federate 
with another OCS/Lync within the enterprise. 
Interdomain federation to OCS/Lync outside the 
enterprise is not supported in unrestricted mode. 

Presence > Inter-domain Federation > XMPP 
Federation > Settings

You cannot configure the security mode; It is set 
to “NO TLS”. 

Presence > Routing > Settings You cannot set any TLS or HTTPS listeners as the 
preferred proxy listener. 

Presence > Routing > Static Routes The TLS option has been removed from the 
Protocol Type drop-down list. 

Presence > Routing > Method/Event Routing The TLS option has been removed from the 
Protocol Type drop-down list. 
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Important Notes
• About Cisco Unified Presence Release 8.6(1), page 19

• About Cisco Unified Presence Release 8.6(2), page 23

• About Cisco Unified Presence Release 8.6(3), page 26

About Cisco Unified Presence Release 8.6(1)
The following sections contain information that may have been unavailable upon the initial release of 
documentation for Cisco Unified Presence Release 8.6(1):

• Exchange Server Status Reports False Positives (CSCtr36119), page 19

• Interoperability Between Different Releases of Cisco Unified Presence, page 20

• Access to Publisher or Subscriber Node after High Availability Failover (CSCtr80524), page 21

• Issue if Node Name is IP Address (CSCtj90392), page 21

• Intermittent Cisco UP XCP Router Hang on Startup Conditions with SIP Federation (CSCts08799), 
page 21

• Cisco Unified Mobility Advantage Client Unable to Sign In to Cisco Unified Presence 
(CSCts48469), page 22

• Physical to Virtual Server Migration, page 22

Exchange Server Status Reports False Positives (CSCtr36119)

Problem

The Exchange Calendar Presence information is not updating end-user presence correctly when it is 
configured in Cisco Jabber and the exchange presence gateway reports all green check boxes for the 
Exchange Server Status.

Cause

The Exchange Server is reachable via IP/DNS and the SSL Certificate is valid, but the actual permissions 
and configuration on the Exchange Server are not setup properly for the account configured to access 
WebDAV or EWS.

Application > IP Phone Messenger > Status The option to send broadcast messages has been 
removed. 

Cisco Unified OS Administration GUI

Security > IPSEC Configuration This menu item has been removed. 

User Options Interface

User Options > IPPM Broadcast Messages This menu item has been removed. 

Export Unrestricted GUI Item Location Description
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Solution

Set up Exchange to work with Cisco Unified Presence and correct all errors showing up on the Exchange 
Server Event Viewer. For more information, see the Integration Guide for Configuring Cisco Unified 
Presence Release 8.5 and 8.6 with Microsoft Exchange here:
http://www.cisco.com/en/US/products/ps6837/products_installation_and_configuration_guides_list.ht
ml

Interoperability Between Different Releases of Cisco Unified Presence

Problem

Configuring intercluster connections between a Cisco Unified Presence 8.6(1) cluster and a cluster 
running Cisco Unified Presence 8.0(x) or 8.5(x) may impact functionality on the Cisco Unified Presence 
8.6(1) cluster; specifically, users may experience one-way presence and IM with users on other Cisco 
Unified Presence 8.6(1) nodes. This does not affect intercluster communication between Cisco Unified 
Presence 8.5 and Cisco Unified Presence 7.x. 

Cause

This condition occurs because the XCP Router component has undergone a fix to address a stability issue 
in Jabber XCP when running Cisco Unified Presence in a very large scale deployment (greater than 26 
nodes). This fix does not allow for backward compatibility with some earlier versions of Cisco Unified 
Presence.

Solution

You must upgrade all clusters to Cisco Unified Presence Release 8.6(1). After you have upgraded the 
remaining Cisco Unified Presence 8.0(x) or 8.5(x) clusters, you must restart the Cisco UP XCP Router 
service on each Cisco Unified Presence 8.6(1) node. This is server impacting. For more information, see 
the Upgrade Guide for Cisco Unified Presence Release 8.6 here:
http://www.cisco.com/en/US/products/ps6837/prod_installation_guides_list.html

Alternatively, you must remove any Cisco Unified Presence 8.0(x) or 8.5(x) intercluster peers from the 
Cisco Unified Presence 8.6(1) clusters and remove any Cisco Unified Presence 8.6(1) intercluster peers 
from the Cisco Unified Presence 8.0(x) or 8.5(x) clusters. The procedure below is service impacting:

Step 1 On each Cisco Unified Presence 8.0(x) or 8.5(x) publisher, select Presence > Inter-Clustering.

Step 2 Select each intercluster peer that is running Cisco Unified Presence 8.6(1) and select Delete Selected 
from the list page or select Delete from the Inter-cluster Peer Configuration page.

Step 3 On each node in the cluster, in the Serviceability GUI, select Tools > Control Center - Network 
Services page and restart the Cisco UP XCP Router service. Note that a notification to this effect will 
display on the Cisco Unified Presence Administration GUI.

Step 4 On each Cisco Unified Presence 8.6(1) publisher, select Presence > Inter-Clustering.

Step 5 Select each intercluster peer that is running Cisco Unified Presence 8.0(x) or 8.5(x) and select Delete 
Selected from the list page or select Delete from the Inter-cluster Peer Configuration page.

Step 6 On each node in the cluster, in the Serviceability GUI, select Tools > Control Center - Network 
Services and restart the Cisco UP XCP Router service. Note that a notification to this effect will display 
on the Cisco Unified Presence Administration GUI.
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Access to Publisher or Subscriber Node after High Availability Failover (CSCtr80524)

Problem

In large scale deployments, following a High Availability failover event, the Cisco Unified Presence GUI 
becomes unresponsive on both the failed-over and failed-to nodes.

Cause

This condition occurs in large scale deployments after a High Availability failover from publisher to 
subscriber. The Cisco Unified Presence GUI on the subscriber is unresponsive while failed over users 
log into the subscriber node.

Solution

If a second subcluster exists in the deployment and it has not failed over, the system administrator will 
have GUI access to the system via one of the nodes in that subcluster. To access the GUI on the failed-to 
node, you must wait until all users have failed over and the system has had time to stabilize. This may 
take between 10 and 15 minutes depending on the number of users and the system hardware.

Issue if Node Name is IP Address (CSCtj90392)

Note This issue has been resolved in Cisco Unified Presence Release 8.6(3).

Problem

Offline messages are not delivered following user re-assignment if node name is set to an IP address. 

Cause

This condition only occurs on intracluster deployments if a user is moved from one node to another. Any 
offline messages stored on the original node are not moved between nodes. As a result, when the user 
signs in, they will not receive any offline messages sent in the time between the user’s last login on the 
original node and the user being moved to the new node. Any subsequent offline messages after this time 
will be received without any issue when the user logs in.

Solution

If you are using a release earlier than Cisco Unified Presence Release 8.5(1), set the node name to 
hostname. If the node name must be an IP address, ensure users login a short time before the move to 
check for offline messages. 

Intermittent Cisco UP XCP Router Hang on Startup Conditions with SIP Federation (CSCts08799)

Note This issue has been resolved in Cisco Unified Presence Release 8.6(2).

Problem

The Cisco UP XCP Router hangs on miscellaneous startup conditions while operating SIP Interdomain 
or Intradomain Federation to Microsoft OCS or AOL. 
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Cause

Miscellaneous startup conditions refer to any event which initiates the creation of the first internal 
composed presence session for a user (for example, Joe_Bloggs@cisco.com). Conditions where this 
creation event occurs include:

• Initial startup after a restart for the Presence Engine and Cisco UP XCP Router

• HA event, user move or restart

A Cisco UP XCP Router hang may occur if simultaneous to any of the creation events listed (for user 
Joe_Bloggs@cisco.com) a corresponding SIP subscribe (caused by an initial MOC/AOL client login or 
refresh subscription) from a MOC or AOL user to Joe_Bloggs@cisco.com occurs. 

If these two events correspond (an extremely rare event), the Cisco UP XCP Router will hang and require 
manual intervention to restart the Cisco UP XCP Router. 

Solution

Restart the Cisco UP XCP Router manually using the Cisco Unified Presence Administration interface. 

Cisco Unified Mobility Advantage Client Unable to Sign In to Cisco Unified Presence (CSCts48469)

Note This issue has been resolved in Cisco Unified Presence Release 8.6(2).

Problem

Any Cisco Unified Mobility Advantage client which uses the Client Configuration SOAP interface of 
Cisco Unified Presence is denied login. 

Cause

This condition occurs after a fresh install or upgrade to Cisco Unified Presence Release 8.6.1.

Solution

During a maintenance widow, the Cisco Unified Presence Administrator must run the following 
commands from the command line interface of the publisher node:

run sql update soapclienttypes set versioncheckrequired='f' where clienttype='CUMCCLIENT'

To restart service on all nodes in the cluster including the publisher node, enter the following command:

utils service restart Cisco UP Client Profile Agent

Physical to Virtual Server Migration

Problem

Prior to Cisco Unified Presence Release 8.6, if you wanted to migrate from a physical Cisco Unified 
Presence server with support for 1000 or 2500 users, you had to move to a virtual server with support 
for 5000 users.

Cause

This condition occurs when the physical server has more than 80GB of storage space, regardless of the 
number of users supported.
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Solution

Perform the following procedure:

Step 1 Perform a backup of the Disaster Recovery System (DRS) on the physical machine as required in a 
normal migration.

Step 2 Deploy a new 5000 user OVA based virtual machine.

Step 3 Before installing the base Cisco Unified Presence OS image, change the following settings on the virtual 
machine:

Step 4 Install the Cisco Unified Presence OS as normal.

Step 5 Perform the DRS restore on the new virtual machine.

About Cisco Unified Presence Release 8.6(2)
The following sections contain information that may have been unavailable upon the initial release of 
documentation for Cisco Unified Presence Release 8.6(2)

• Number of Cisco Unified Presence Users Supported, page 23

• Interoperability with Microsoft Communicator Web Access (CWA) 2005, page 25

• MCS-7835-I2 or MCS-7845-I2 Server in Read-Only State (CSCtr00304), page 26

Number of Cisco Unified Presence Users Supported

Table 3 identifies the number of users that Cisco Unified Presence Release 8.5(x) and 8.6 can sustain for 
Cisco Unified Communications mode depending on your server type and your deployment strategy.

If... Then...

You are migrating to the 1000 user OVA 
specification

Perform the following steps in the specified order:

• Reduce the memory to 2GB (4GB for Cisco 
Unified Presence Release 8.6.2 or above.

• Reduce the CPU count to 1.

• Go to the Resources tab and set the CPU 
Reservation to 800MHz and the Memory 
Reservation to 2048MB.

You are migrating to the 2500 user OVA 
specification

Perform the following steps in the specified order:

• Reduce the memory to 4GB.

• Reduce the CPU count to 2.

• Go to the Resources tab and set the CPU 
Reservation to 2000MHz and the Memory 
Reservation to 4096MB.
23
Release Notes for Cisco Unified Presence Releases 8.6(1), 8.6(2), 8.6(3), and 8.6(3)a

 



 

  Important Notes
Table 3 Cisco Unified Presence 8.5(x) and 8.6 Capacities

Cisco Unified Communications Mode

Deployment Model Platform Model

Number of Users 
Supported

Number of Users 
Supported 

(Guaranteed High 
Availability)

8.5(x) 8.6 8.5(x) 8.6

Single Node MCS78161 500 1000

Single Node MCS78251 1000 2000

Single Node
MCS78351 

(or UCS B series / C series equivalent)
2500 5000

Single Node
MCS78451 

(or UCS B series / C series equivalent)
5000 15000

 Multi-Node Cluster (6 nodes) MCS78161 3000 3000 1500 3000

 Multi-Node Cluster (6 nodes) MCS78251 6000 6000 3000 6000

 Multi-Node Cluster (6 nodes)
MCS78351 

(or UCS B series / C series equivalent)
15000 15000 7500 15000

 Multi-Node Cluster (6 nodes)
MCS78451 

(or UCS B series / C series equivalent)
30000 45000 15000 45000

1. Validated against 7816-I5, 7825-I5, 7835-I5, 7845-I3 HW
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Table 4 identifies the number of users that Cisco Unified Presence Release 8.5(x) and 8.6 can sustain for 
IM–Only Mode depending on your server type and your deployment strategy.

If you are deploying two or more nodes in your Cisco Unified Presence installation, use the multi-node 
feature in Cisco Unified Presence and ensure that your hardware is compatible with this feature. This is 
necessary for both a fresh install and upgrade of Cisco Unified Presence. 

Related Topic

See the Deployment Guide for Cisco Unified Presence for more information about specific multi-node 
deployment strategies and hardware support information for a multi-node deployment.

Interoperability with Microsoft Communicator Web Access (CWA) 2005

Problem

Microsoft Communicator Web Access (CWA) is only supported when TLS encryption is NOT enabled 
between Cisco Unified Presence and Microsoft LCS. 

Cause

Federal Information Processing Standard (FIPS) compliance must be enabled on LCS to support TLSv1 
encryption and TSLsv1 encryption is required by Cisco Unified Presence; however, CWA does NOT 
support FIPS compliance.

Table 4 Cisco Unified Presence 8.5(x) and 8.6 Capacities

IM–Only Mode

Deployment Model Platform Model

Number of Users 
Supported

Number of Users 
Supported 

(Guaranteed High 
Availability)

8.5(x) 8.6 8.5(x) 8.6

Single Node MCS78161 1500 2500

Single Node MCS78251 3000 5000

Single Node
MCS78351 

(or UCS B series / C series equivalent)
7500 12500

Single Node
MCS78451 

(or UCS B series / C series equivalent)
15000 25000

 Multi-Node Cluster (3 nodes) MCS78161 
Not 

Quantified
7500

Not 
Quantified

7500

 Multi-Node Cluster (3 nodes) MCS78251 Not 
Quantified

15000
Not 

Quantified
15000

 Multi-Node Cluster (3 nodes)
MCS78351 

(or UCS B series / C series equivalent)
Not 

Quantified
37500

Not 
Quantified

37500

 Multi-Node Cluster (3 nodes)
MCS78451 

(or UCS B series / C series equivalent)
45000 75000

Not 
Quantified

75000

1. Validated against 7816-I5, 7825-I5, 7835-I5, 7845-I3 HW
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Solution

None

MCS-7835-I2 or MCS-7845-I2 Server in Read-Only State (CSCtr00304)

Problem

The file system goes into a read-only state following an upgrade to Cisco Unified Presence Release 
8.5(x), 8.6(1), and 8.6(2).

Cause

This condition occurs only on MCS-7835-I2 and MCS-7845-I2 class of servers and only after they have 
been upgraded to Cisco Unified Communications Manager Release 8.5(x). This issue does not occur 
after a fresh install. 

Solution

Contact the Technical Assistance Center (TAC) for access to the required patch file.

About Cisco Unified Presence Release 8.6(3)
There are no important notes to be highlighted in this release.

Caveats
• Using Bug Toolkit, page 26

• Open Caveats, page 27

• Resolved Caveats, page 29

Using Bug Toolkit
Known problems (bugs) are graded according to severity level. These release notes contain descriptions 
of the following:

• All severity level 1 or 2 bugs.

• Significant severity level 3 bugs.

• All customer-found bugs.

You can search for problems by using the Cisco Software Bug Toolkit.

Before You Begin

To access Bug Toolkit, you need the following items:

• Internet connection

• Web browser

• Cisco.com user ID and password
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Procedure

Step 1 To access the Bug Toolkit, go to 
http://tools.cisco.com/Support/BugToolKit/action.do?hdnAction=searchBugs.

Step 2 Sign in with your Cisco.com user ID and password.

Step 3 To look for information about a specific problem, enter the bug ID number in the “Search for Bug ID” 
field and, then select Go.

For information about how to search for bugs, create saved searches, and create bug groups, select Help 
on the Bug Toolkit page.

Open Caveats
The caveats in Table 5 describe possible unexpected behavior in the latest Cisco Unified Presence 
release. These caveats may also be open in previous releases. Bugs are listed in alphabetical order by 
component and then in numerical order by severity.

Table 5 Open Caveats for Cisco Unified Presence Release 8.6(x)

Identifier Severity Component Headline

CSCtt11329 3 axl AXL timeouts for enduser list request from ICSA.

CSCtb19086 6 bat CUPS BAT functionality enhancement needed - SIP static routes

CSCtr71144 4 ctigw Failure in building conference event.

CSCtq56972 4 ctigw CTIGW: Add protection code against core due to misconfigured Tel Uri

CSCtr66310 6 ctigw Cisco Unified Presence needs to release QBE session in Receiving BYE 
without INFO<MonitorStop>

CSCta42149 6 ctigw Remote Call Control feature fails for users with apostrophe (‘) in their OCS 
sing-in ID

CSCtu58771 2 database DBReplication hanging, error 77 not being handled correctly.

CSCto77824 3 database Users have inconsistent presence after Cisco Unified Presence upgrade.

CSCtr97444 3 database Entries in Roster table get changed during upgrade to Cisco Unified 
Presence Release 8.6(1).

CSCtt26378 3 database Unable to sync user information from Cisco Unified Communications 
Manager when the mail ID case is changed.

CSCtt31840 3 database Handle duplicate entries in roster table during domain change 

CSCtr49324 3 database db: repl not getting setup after 3 hours as cdr process was hung.

CSCtt88811 4 database Rosters on one of the presence nodes goes to a disabled state.

CSCtn62906 4 database Incorrect destination ports for MER after upgrade from 7.x to 8.x.

CSCti65280 6 database Database reported as started when it may in fact be stopped.

CSCtt03815 3 database-ids Replication gets out of sync after implementation of ifx_replcheck.
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CSCts65285 6 database-install upgrading Cisco Unified Communications Manager Business Edition to 
Cisco Unified Communications Manager deleted all Cisco Unified Presence 
server info.

CSCsv83749 6 epe EPE: Remove ODBC driver manager.

CSCtr21560 6 epe EPE: Enhance Calendar Integration to support SAN certs

CSCtr21577 6 epe EPE: Enhance Calendar Integration to support Wildcard certs

CSCtw75609 3 epe-rs RosterSyncAgent leaves pending watcher in group.

CSCtw75593 3 epe-rs RosterSyncAgent should delete group immediately.

CSCtq61000 4 esp SCB failed RTMT alerts when we add devices to application user.

CSCtu42689 4 esp Phone presence not shown in Cisco Jabber when CUPS hostname starts a 
number.

CSCtt95533 3 gui-admin Errors in contact’s view on End User page.

CSCtj69153 5 gui-admin Presence Viewer reports remote user as local.

CSCts26178 6 gui-admin Site ID and Partner ID for WebEx Configuration

CSCtr36119 3 gui-troubleshooter Exchange Server Status reports false positives.

CSCtr07016 6 gui-troubleshooter troubleshooter to report subscriptions with state NONE.

CSCsx61535 6 gui-troubleshooter Adding test to system troubleshooter

CSCtr80524 3 gui Unable to access Cisco Unified Presence GUI on publisher or subscriber 
after High Availability failover.

CSCte19441 3 gui Intercluster Sync Agent status needs to be on all nodes in topology.

CSCto15831 4 gui CUPS GUI does not list more than 150 profiles in the drop-down list.

CSCtr07051 4 gui Re-wording pending subscription from presence viewer.

CSCtn60644 6 gui CUPS 8.5.1 LDAPS Server configuration should say “SSL” instead of 
“TLS”

CSCtg72676 6 gui explicit field for Cisco Jabber LDAP search filter

CSCtn92838 6 ippm Add ability to IPPM to specify the ringtone used by the phone

CSCto29137 6 ippm 792X not playing Audio Ring when IP Phone Messenger Service is selected.

CSCts11780 5 licensing License Unit Report only displays 1 unit when 2 sip proxy are running.

CSCts53870 3 oamagent Delay in writing pe-cfg.xml upon L2 causes Presence Engine to start in bad 
state.

CSCtt44582 3 serviceability Cisco Unified Presence has several redundant services on the Serviceability 
GUI.

CSCtt79854 3 serviceability AlertCentral and CoreDumpFileFound alert properties XML parse error.

CSCts28606 3 serviceability UNKNOWN_ALARM alerts sent to remote syslog router on router restart.

CSCts61745 3 serviceability Syslog messages dropped when router debug logging enabled.

CSCts98273 3 serviceability SNMP requests time out after a Cisco Unified Presence upgrade.

CSCtn01570 4 serviceability CUPS 8.5.1 RTMT installer shows version 8.5 after install about shows 8.7

CSCte50676 4 soap-interface Newly added users cannot login over soap following DB restart

Table 5 Open Caveats for Cisco Unified Presence Release 8.6(x)

Identifier Severity Component Headline
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Resolved Caveats 
This section lists caveats that are resolved but that may have been open in previous releases.

Bugs are listed in alphabetical order by component and then in numerical order by severity. Because 
defect status continually changes, be aware that this document reflects a snapshot of the defects that were 
resolved at the time this report was compiled. For an updated view of resolved defects, access the Bug 
Toolkit (see the “Using Bug Toolkit” section on page 26).

• Cisco Unified Presence Release 8.6(1), page 29

• Cisco Unified Presence Release 8.6(2), page 31

• Cisco Unified PresenceRelease 8.6(3), page 32

• Cisco Unified Presence Release 8.6(3)a, page 33

Cisco Unified Presence Release 8.6(1)

Table 6 lists caveats that are resolved in Cisco Unified Presence Release 8.6(1) but that may have been 
open in previous releases.

CSCtt14874 3 sync-agent Changes to a user’s digest credential in CUCM not synced to Cisco Unified 
Presence.

CSCtq21670 6 sync-agent Sync Agent Not Detecting Changed Credential Policy.

CSCtu27835 3 uccn High Availability enable/disable change notification applied to all 
subclusters.

CSCth59639 3 xcp-jsm Out-of-room message stanzas not stored in offlinemsgs.

CSCtl04121 6 xcp-jsm Cisco Unified Presence/Cisco Jabber: Offline message suppression and IM 
service deactivation.

CSCtj86542 3 xcp-libjcore Cisco Unified Presence server throws a TLS “decrypt error” on certs with 
sha256 algorithm.

CSCts40539 3 xcp-routefabric 8.5 routers in an 8.6 mesh can corrupt routing table.

CSCtj84376 3 xcpsecurity Cisco Unified Presence server throws a TLS “decrypt error” on certs with 
sha256 algorithm

Table 5 Open Caveats for Cisco Unified Presence Release 8.6(x)

Identifier Severity Component Headline

Table 6 Resolved Caveats for Cisco Unified Presence Release 8.6(1)

Identifier Severity Component Headline

CSCtf57354 3 axl getVoicemailProfile error when voicemessagingpilot tag is included.

CSCto85761 3 bat Cannot reassign users to a node using BAT.

CSCtn86627 3 bat BAT:Assign 30K users to SC’s failed, memory issue and Jabberd core.

CSCtl06105 3 config-agent Calendar Module mod_sip_calendar not getting configured.

CSCto55940 3 config-agent ConfigAgent comments out back up MERT in error.

CSCto42782 3 ctigw CUPS RCC puts first call on hold on a shared line with second call 
Resume.
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CSCto77666 2 cupxcpconfig XCP Config Mgr: startup race condition with jabberd causes missing 
R2R.

CSCtl17960 3 cupxcpconfig R2R not being created correctly for intracluster nodes.

CSCto08832 3 cupxcpconfig Jabberd unable to start due to null password in R2R configuration file.

CSCto42251 2 database Stored Procedure - cupsDeleteGateway taking too long to run.

CSCto50574 3 database Non-replicated CDR time table records not dropped on SUBs.

CSCto53237 3 database Duplicate entries found in enduser table for the same remote cluster.

CSCtq46677 3 database Update version of IDS to UC5XI.

CSCto58839 3 database Port CUCM CSCtn81416: cmoninit is too high priority

CSCto77930 3 database DB: Fix entry for Czech Calendar Folder name.

CSCto83389 3 database CUP 8.5.1 Upgrade Hangs on Post Install at “Starting 
cupOnL2BootInitd”.

CSCtl40757 3 database CA user move operations fails to migrate DB information.

CSCtk62844 3 database L2 fails: “Missing key in referenced table for referential constraint”.

CSCtl93858 3 database calendar record is not updated on proxy domain change.

CSCtn69911 3 database CUP Subscriber Fails to Upgrade.

CSCto08640 3 database Some users are unlicensed but assigned.

CSCto09993 3 database Existent record cannot be deleted - SQL/ISAM error 240/111.

CSCtq43284 3 database-tt TT: ttDestroy on ttreg and ttlogin sometimes fails on switch version.

CSCto48374 2 epe Presence Engine does not start after reverting a Switch Version operation.

CSCtl53304 3 epe Phone Presence not showing on ST when user failback from Failover.

CSCtq41259 3 epe Presence Engine (PE): Core on user moveIn from subcluster peer when 
DND on phone.

CSCtq86157 3 epe Having users with blank userid in CUCM when updated in CUCM 
crashes PE.

CSCtq46801 3 epe EPE: EWS core after Calendar Gateway Change.

CSCtl97498 2 esp SIP Proxy cores handling TLS traffic with TLS logging enabled.

CSCtq40192 3 esp Proxy not distributing requests via static routes on a per request basis.

CSCtq65613 3 esp CUPS 8.5.2 Core Dumping due to routeEmbedTemplate on receipt of 
traffic.

CSCtn62616 3 esp Proxy:Routes failover publish to failed node instead of local PE.

CSCtl06668 3 esp IPPM: Today’s Meeting Query Fails.

CSCti55606 3 geolog Additional Counters for Geolog.

CSCtq01630 3 gui-admin Admin GUI: User Mgmt > End User > Logged-in CUPC error.

CSCto42475 3 gui-troubleshoot
er

Users that are only licensed on one cluster are being reported as duplicate 
users.

CSCtn78105 3 gui User should be prompted to restart Tomcat after regenerating cert

Table 6 Resolved Caveats for Cisco Unified Presence Release 8.6(1) (continued)

Identifier Severity Component Headline
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Cisco Unified Presence Release 8.6(2)

Table 7 lists caveats that are resolved in Cisco Unified Presence Release 8.6(2) but that may have been 
open in previous releases.

Table 7 Resolved Caveats for Cisco Unified Presence Release 8.6(2)

CSCtn51530 3 gui ALL-LANG: CUPAdmin:Error occurs on Third-Party Compliance 
Servers.

CSCtk95344 3 gui User Group>Presence Viewer Link Broken.

CSCtl79049 3 gui CUPUser: login/Logout buttons are not localized

CSCsz45780 3 gui SIP Proxy Restart Needed When Changing Deskphone Control CTI 
Address.

CSCtl79253 3 gui KO+ZHS: CUPAdmin: TS Strings translated in TBU appear 
untranslated.

CSCto76844 3 intercluster ICSA cleans up remote users synced from a 7.x/8.0.x peer.

CSCtn62966 3 intercluster ICSA should not be started while DB replication is being setup initially.

CSCto16906 3 intercluster Huge number of ICSA sessions resulting in memory growth.

CSCtj88507 3 serviceability XCP Component not shutting down gracefully.

CSCtn46458 3 serviceability Subscriber Network Service Page not fully displayed.

CSCtn67324 3 serviceability ETSGJ-CH: CUPS CLI which should not allow NTP configuration 
updates.

CSCto42272 3 serviceability Upgrading CUP creates a network interface SNMP issue.

CSCtn05111 3 serviceability SNMP Master Agent will not start on a VM.

CSCto16723 3 soap-interface ETSGC: Empty client information in CUPC user settings page.

CSCtn77929 3 xcp-jsm Jabberd core in mod_privacy when processing roster change.

CSCtq15159 3 xcp-libjcore Shutdown core in SIP S2S

CSCto44692 2 xcp-logging JabberdVosLogger attempt to update Counter with bad data.

CSCto74079 2 xcp-routefabric PE exits when component threadpool has uncaught exception.

CSCtn99337 3 xcp-routefabric jabberd does not decrypt server dialback secret when sent by 
XcpCfgMgr.

CSCto71151 3 xcp-routefabric Port CoDev router refactor to CUP.

CSCtj64775 3 xcp-s2s Email ID not shown on persistent chat room when federating.

CSCtk65345 3 xcp-textconf TC: cores during TC Manager service start using controlcenter.sh

CSCte39103 3 xcpdb jabberd cores when IDS is brought down while it is still running.

Table 6 Resolved Caveats for Cisco Unified Presence Release 8.6(1) (continued)

Identifier Severity Component Headline

Identifier Severity Component Headline

CSCtt41706 3 axl AXL: Duplicate files cause LowActivePartitionAvailableDiskSpace

CSCts21263 2 database ICSA sync fails with large remote clusters, leading to IDS OOM core.

CSCts48469 3 soap-interface CUMA Client unable to login on Cisco Unified Presence.
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  Caveats
Cisco Unified PresenceRelease 8.6(3)

Table 8 lists caveats that are resolved in Cisco Unified Presence Release 8.6(3) but that may have been 
open in previous releases.

Table 8 Resolved Caveats for Cisco Unified Presence Release 8.6(3)

CSCts08799 3 xcp Intermittent Jabberd hang on Startup Conditions with SIP Federation.

CSCts40470 2 xcp-logging stats logging can cause jabberd OOM core.

CSCts50398 3 xcp-sipgw Cisco Jabber “Busy” shown as “Available” to MOC watcher on initial 
SUBSCRIBE.

Identifier Severity Component Headline

Identifier Severity Component Headline

CSCtj90392 3 config-agent Config agent fails to connect to informix if node name is IP address.

CSCtr17903 3 cupxcpconfig XCP Router failed to start on publisher node in 5 cluster intercluster 
setup.

CSCti55144 3 database FreeConnectionFailover - sub failover, jabberd, cm, jds cores

CSCts88667 3 epe PE xcpPresenceThrottle algorithm starves users.

CSCts80264 3 epe Toggline of Presence State to “Available” may result in “Offline” 
Presence State.

CSCts66760 6 epe Clear manually set presence when no IM capable devices are logged in.

CSCtw49903 3 epe-rs Adding contact as part of subs authorization intermittently fails.

CSCtw70016 3 epe-rs Roster Sync Queue deletes roster entry in error of pending watcher

CSCtw52100 3 esp SIP Proxy IDS Queries slow down processing of SIP requests.

CSCts42800 3 gui Cluster Topology Erroneously Showing Error With High Availability.

CSCtt07948 3 gui Node status not retrieved on multinode cluster topology page.

CSCtq37491 6 gui Mechanism for tracking XMPP and Cisco Jabber Release 8.x user login 
on Cisco Unified Presence.

CSCts15430 3 intercluster ICSA not setting correct Protocol/Port for intercluster subclusters.

CSCts32407 3 intercluster ICSA fails to sync on non-TLS builds

CSCts44116 3 serviceability Serviceability reports archive is not working.

CSCts21387 3 serviceability Options missing on Alarm Config page on Serviceability GUI.

CSCts38102 3 serviceability Platform SOAP Service can not be started in Troubleshooting Trace 
Settings.

CSCtr00304 3 vos MCS 7845-I2 file system goes into read-only state: IBM RAID Driver 
not installed.

CSCtt49101 3 xcp-jsm Error is not reaching Cisco Jabber if the max contacts limit is exceeded.

CSCtw70037 3 xcp-jsm max-contacts/max-watchers bugs in mod_roster

CSCts00097 4 xcp-jsm JSM session instances are not being cleared.

CSCts46240 3 xcp-logging TC stats counters are incorrect.
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  Documentation Updates
Cisco Unified Presence Release 8.6(3)a

Table 9 Resolved Caveats for Cisco Unified Presence Release 8.6(3)a

Documentation Updates
For the latest versions of all Cisco Unified Presence documentation, go to 
http://www.cisco.com/en/US/products/ps6837/tsd_products_support_series_home.html

This section contains updates to the following documents:

• Cisco Unified Presence Release 8.6(1), page 33

• Cisco Unified Presence Release 8.6(2), page 38

• Cisco Unified Presence Release 8.6(3), page 39

Cisco Unified Presence Release 8.6(1)
• Online Help Updates, page 34

• Integration Guide for Configuring Partitioned Intradomain Federation for Cisco Unified Presence 
Release 8.6 and Microsoft LCS/OCS, page 35

• Installation Guide for Cisco Unified Presence Release 8.6, page 35

• Upgrade Guide for Cisco Unified Presence Release 8.6, page 35

• Integration Guide for Configuring Cisco Unified Presence Release 8.6 for Interdomain Federation, 
page 36

• Integration Guide for Configuring Cisco Unified Presence Release 8.6 with Microsoft Lync Server 
for Remote Call Control, page 36

• Deployment Guide for Cisco Unified Presence Release 8.6, page 36

• Command Line Interface (CLI) Reference Guide for Cisco Unified Presence Release 8.0, 8.5, and 
8.6, page 37

• User Guide for Cisco IP Phone Messenger Release 8.0, 8.5, and 8.6, page 37

• Integration Note for Configuring Cisco Unified Presence Release 8.0, 8.5, and 8.6 with Microsoft 
OCS for Microsoft Office Communicator, page 37

• Integration Guide for Configuring Cisco Unified Presence Release 8.5 and 8.6 with Microsoft 
Exchange, page 38

• Hardware and Software Compatibility Information for Cisco Unified Presence Release 8.x, page 38

CSCtu32832 2 xcp-libjcore CM core in SASLManager if no ‘to’ in <stream:stream>

CSCts15782 3 xcp-s2s Certificate parsing error causes XMPP Federation CM to restart.

Identifier Severity Component Headline

CSCtx86633 2 vos GUI and DB in “restricted mode” instead of “unrestricted mode” in Cisco 
Unified Presence XU.

Identifier Severity Component Headline
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  Documentation Updates
Online Help Updates

• BAT Configuration Topics, page 34

• Cisco Unified Communications Manager Publisher Configuration, page 34

• Cisco Jabber User Query, page 34

• Cisco Unified Presence Configuration, page 34

• Presence Gateway Configuration, page 34

• SIP Federated Domain Configuration, page 35

• System Troubleshooter Configuration, page 35

• Voicemail Profile Configuration for Cisco Unified Personal Communicator, page 35

BAT Configuration Topics

The following topics were updated:

• View Sample File topic—updated to clarify that you must now download files larger than 1MB to 
view them.

• Job Descriptions topic—corrected to indicate that the maximum length is 100 characters and that all 
characters are allowed except ampersand (&), double quotes (“), less than (<), greater than (>), 
percent sign (%), and backslash (\).

The following new topics were added:

• BAT Configuration to Update Users’ Contact Lists—updated to indicate support for new product 
features.

• BAT Configuration to Upload and Download Files—updated to include information for contact lists.

Cisco Unified Communications Manager Publisher Configuration

Information was added about Sync Status.

Cisco Jabber User Query

A new help topic was created to describe possible client types.

Cisco Unified Presence Configuration

The following topics were updated:

• Maximum Contact List Size—updated to include a new option for choosing no limit to the 
maximum contact list size.

• CUCM SIP Publish Trunk—updated to reflect UI changes and specify that Cisco Unified 
Communications Manager 5.x and older do not support phone availability for Cisco Unified 
Presence using PUBLISH.

• Partitioned Intradomain Federation with LCS/OCS Settings—updated to include content for a new 
feature.

Presence Gateway Configuration

The content of this topic was updated to reflect the ability to change the gateway type. Guidelines for 
migrating between WebDAV and EWS gateways were also added.
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  Documentation Updates
SIP Federated Domain Configuration

Information was added about direct federation to include support for SIP interdomain federation with a 
Microsoft OCS domain within an enterprise.

System Troubleshooter Configuration

Details were added for the new Intercluster Troubleshooter test that verifies which Cisco Unified 
Presence server is currently running the active Cisco UP Intercluster Sync Agent service.

Voicemail Profile Configuration for Cisco Unified Personal Communicator

The No Voice Mail option was removed because not selecting a number for the voicemail pilot number 
has the same effect.

Integration Guide for Configuring Partitioned Intradomain Federation for Cisco Unified Presence 
Release 8.6 and Microsoft LCS/OCS

The Integration Guide for Configuring Partitioned Intradomain Federation for Cisco Unified Presence 
Release 8.6 and Microsoft LCS/OCS is a new document that describes how to configure partitioned 
intradomain federation between Cisco Unified Presence Release 8.6(1) and Microsoft LCS/OCS. 

For more information, see the Integration Guide for Configuring Partitioned Intradomain Federation for 
Cisco Unified Presence Release 8.6 and Microsoft LCS/OCS here:
http://www.cisco.com/en/US/products/ps6837/products_installation_and_configuration_guides_list.ht
ml

Installation Guide for Cisco Unified Presence Release 8.6

The Installation Guide for Cisco Unified Presence Release 8.6 is a new document in this release. 
Installation-related information was taken from the Installation and Upgrade Guide for Cisco Unified 
Presence Release 8.0 and 8.5 and restructured. 

For more information, see the Installation Guide for Cisco Unified Presence Release 8.6 here:
http://www.cisco.com/en/US/products/ps6837/prod_installation_guides_list.html

Upgrade Guide for Cisco Unified Presence Release 8.6

The Upgrade Guide for Cisco Unified Presence 8.6 is a new document in this release. Upgrade-related 
information was taken from the Installation and Upgrade Guide for Cisco Unified Presence Release 8.0 
and 8.5 and restructured. 

The following upgrade paths are supported in this release:

• Upgrade from Cisco Unified Presence Release 7.x to Release 8.6(1)

• Upgrade from Cisco Unified Presence Release 8.0(x) to Release 8.6(1)

• Upgrade from Cisco Unified Presence Release 8.5(1) to Release 8.6(1)

For more information, see the Upgrade Guide for Cisco Unified Presence 8.6 here: 
http://www.cisco.com/en/US/products/ps6837/prod_installation_guides_list.html
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  Documentation Updates
Integration Guide for Configuring Cisco Unified Presence Release 8.6 for Interdomain Federation

The Integration Guide for Configuring Cisco Unified Presence Release 8.0 and 8.5 for Interdomain 
Federation was updated to include support for Direct Federation within an Enterprise. The following 
updates were made to this document:

• A new configuration workflow was added for SIP Federation with Microsoft OCS/Lync within an 
Enterprise.

• A new step was added to the “Adding a SIP Federated Domain” procedure. You must ensure that 
Direct Federation is unchecked if you are configuring federation with Microsoft OCS.

• A new procedure was added: “Adding a Microsoft OCS Domain within an Enterprise”.

For more information, see the Integration Guide for Configuring Cisco Unified Presence Release 8.0 and 
8.5 for Interdomain Federation here:
http://www.cisco.com/en/US/products/ps6837/products_installation_and_configuration_guides_list.ht
ml

Integration Guide for Configuring Cisco Unified Presence Release 8.6 with Microsoft Lync Server for 
Remote Call Control

The Integration Guide for Configuring Cisco Unified Presence Release 8.6 with Microsoft Lync Server 
for Remote Call Control was updated to include a new chapter for TLSv1 support: “Security Between 
Cisco Unified Presence and Microsoft Lync”.

For more information, see the Integration Guide for Configuring Cisco Unified Presence Release 8.6 
with Microsoft Lync Server for Remote Call Control here:
http://www.cisco.com/en/US/products/ps6837/products_installation_and_configuration_guides_list.ht
ml

Deployment Guide for Cisco Unified Presence Release 8.6

The Deployment Guide for Configuring Cisco Unified Presence Release 8.6 was updated as follows:

• Enhancements to the High Availability feature were captured. 

• The Cross-Cluster Login Redirect feature was documented.

• Installation- and upgrade-related information was moved from this document to the Installation 
Guide for Cisco Unified Presence Release 8.6 and Upgrade Guide for Cisco Unified Presence 
Release 8.6, respectively.

• The section “Bulk Import of User Contact Lists” was added to this document to indicate support for 
pre-populating contact lists for new Cisco Unified Presence client users or add to existing contact 
lists.

• The section “Intercluster Hardware Recommendations” was added to this document to recommend 
that similar hardware be used on all Cisco Unified Presence clusters in the Enterprise to allow for 
syncing of all user data between clusters. An example is included in this section to highlight this 
recommendation.

• The section “Multi-Node Hardware Recommendations” was updated to include a warning. In 
multi-node deployments using mixed hardware, publisher and subscriber nodes in the same 
subcluster should have similar database size.

• The section “IM Forking” was updated with a note stating IM forking is not supported when using 
Cisco IP PhoneMessenger (IPPM) with Cisco Jabber Release 7.0.
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  Documentation Updates
• The procedure “Configuring the SIP Publish Trunk on Cisco Unified Presence” was changed to 
reflect GUI updates.

For more information, see the Deployment Guide for Cisco Unified Presence Release 8.6 here:
http://www.cisco.com/en/US/products/ps6837/products_installation_and_configuration_guides_list.ht
ml

Command Line Interface (CLI) Reference Guide for Cisco Unified Presence Release 8.0, 8.5, and 8.6

The Command Line Interface Reference Guide for Cisco Unified Presence Release 8.0, 8.5, and 8.6 was 
updated to include the following commands:

• utils ntp config

• utils import config

• utils ntp restart

• utils ntp server list

Note The utils ntp server list command is only supported in Cisco Unified Presence Release 8.5 and 8.6(1).

• utils ntp start

• utils ntp status

For more information, see the Command Line Interface Reference Guide for Cisco Unified Presence 
Release 8.0, 8.5, and 8.6 here:
http://www.cisco.com/en/US/products/ps6837/prod_maintenance_guides_list.html

User Guide for Cisco IP Phone Messenger Release 8.0, 8.5, and 8.6

The User Guide for Cisco IP Phone Messenger Release 8.0, 8.5, and 8.6 was updated to include tips for 
Adding a Contact by Extension Number and Displaying the Availability of a Contact.

For more information, see the User Guide for Cisco IP Phone Messenger Release 8.0, 8.5, and 8.6 here:
http://www.cisco.com/en/US/products/ps6837/products_user_guide_list.html

Integration Note for Configuring Cisco Unified Presence Release 8.0, 8.5, and 8.6 with Microsoft OCS 
for Microsoft Office Communicator

The Integration Note for Configuring Cisco Unified Presence Release 8.5 and 8.6 with Microsoft OCS 
for Microsoft Office Communicator Call Control was updated with a note stating that you must disable 
High Availability on the Cisco Unified Presence server prior to integrating the server with Microsoft 
OCS.

For more information, see the Integration Note for Configuring Cisco Unified Presence Release 8.5 and 
8.6 with Microsoft OCS for Microsoft Office Communicator Call Control here:
http://www.cisco.com/en/US/products/ps6837/products_installation_and_configuration_guides_list.ht
ml
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  Documentation Updates
Integration Guide for Configuring Cisco Unified Presence Release 8.5 and 8.6 with Microsoft 
Exchange

The Integration Guide for Configuring Cisco Unified Presence Release 8.0, 8.5, and 8.6 with Microsoft 
Exchange was updated as follows:

• A new procedure was added for Enabling Calendar Integration. 

• A note was added to the procedure Configuring the Presence Gateway on Cisco Unified Presence 
for Microsoft Exchange Integration. You can now upgrade or downgrade your Cisco Unified 
Presence server without impacting the calendar presence for all users. The block disabling of user 
calendaring only happens when you delete the WebDAV gateway or the last EWS gateway.

• A table was added to the Scale Limitations for Calendaring Integrations section to include 
percentages for multiple releases.

• Steps were added to the procedure for Enabling Authentication on Exchange 2010 Running 
Windows Server 2008.

• A step was added to the procedure for Verifying Permissions on the Exchange 2010 Account. 

• Steps were added to Table 3-3 Configuration tasks for Microsoft Exchange 2010 Components.

For more information, see the Integration Guide for Configuring Cisco Unified Presence Release 8.0, 
8.5, and 8.6 with Microsoft Exchange here:
http://www.cisco.com/en/US/products/ps6837/products_installation_and_configuration_guides_list.ht
ml

Hardware and Software Compatibility Information for Cisco Unified Presence Release 8.x

The Hardware and Software Compatibility Information for Cisco Unified Presence Release 8.x has been 
updated to include VMware support for HP and IBM servers. This document has also been updated to 
replace Cisco ASA version 8.0(4) support with Cisco ASA version 8.4(1) support in Cisco Unified 
Presence Release 8.6(1). In addition, a section for Intradomain Federation has been added to the table 
listing supported Cisco Unified Presence Federations.

For more information, see the 
http://www.cisco.com/en/US/products/ps6837/products_device_support_tables_list.html

Cisco Unified Presence Release 8.6(2)
• Deployment Guide for Cisco Unified Presence Release, page 38

• Integration Guide for Configuring Partitioned Intradomain Federation for Cisco Unified Presence, 
page 39

Deployment Guide for Cisco Unified Presence Release

Release 8.0 and 8.5 as well as release 8.6 of the Deployment Guide was updated to include two additional 
chapters: Configuring Active Directory for Cisco Jabber and Configuring Additional Registry Keys for 
Cisco Jabber.

This document was also updated to identify the Cisco Unified Presence applications that are localized 
as well as the languages they support. 
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  Documentation Updates
For more information, see the Deployment Guide for Cisco Unified Presence here: 
http://www.cisco.com/en/US/products/ps6837/products_installation_and_configuration_guides_list.ht
ml

Integration Guide for Configuring Partitioned Intradomain Federation for Cisco Unified Presence

This document was updated to include a note in the Microsoft LCS/OCS Supported Clients section to 
highlight that Communicator Web Access 2005 is only supported when TLS encryption is not enabled 
between Cisco Unified Presence and Microsoft LCS.

For more information, see the Integration Guide for Configuring Partitioned Intradomain Federation for 
Cisco Unified Presence here: 
http://www.cisco.com/en/US/products/ps6837/products_installation_and_configuration_guides_list.ht
ml

Cisco Unified Presence Release 8.6(3)
• Online Help Updates, page 39

• Documentation Updates, page 40

• Deployment Guide for Cisco Unified Presence, page 40

• User Guide for Cisco Unified Presence, page 40

• Integration Guide for Configuring Cisco Unified Presence Release 8.6 for Interdomain Federation, 
page 41

• Real-Time Monitoring Tool Administration Guide for Cisco Unified Presence Release 8.0, 8.5, and 
8.6, page 41

• Integration Guide for Configuring Cisco Unified Presence Release 8.6 with Microsoft Lync Server 
2010 Remote Call Control, page 41

• Integration Guide for Configuring Partitioned Intradomain Federation for Cisco Unified Presence 
Release 8.6 and Microsoft LCS/OCS, page 41

• Integration Note for Configuring Cisco Unified Presence Release 8.0, 8.5, and 8.6 with Microsoft 
OCS for MOC Call Control, page 42

Online Help Updates

Cisco Unified Presence Configuration and Maintenance, page 39

Cisco Unified Presence Configuration and Maintenance

The following updates were made to the content in this topic:

• References to Cisco Unified Personal Communicator Release 8.x were replaced with Cisco Jabber.

• References to Desk Phone Remote Call Control (RCC) were replaced with Microsoft RCC.

• The Client Type Query topic was added to include details about the new Client Type page 
(Application > Client Type).

• The End User Information Query was updated to include the following:

– The change from Logged-in CUPC Find Option to Logged-in XMPP Users
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– The requirement for sorting by Contacts and Watchers

– The Troubleshooting Tip indicating that queries may take a long time in large deployments

Documentation Updates

Most references to Cisco Unified Personal Communicator Release 8.x have been changed to Cisco 
Jabber in the following documents:

Note For information about how to deploy Cisco Unified Personal Communicator, see the Deployment Guide 
for Cisco Unified Presence Release 8.6. For information specific to other Cisco clients (such as Cisco 
Jabber for Mac or Cisco Jabber for IM), see the appropriate client documentation.

• Changing the IP Address and Hostname for Cisco Unified Presence Release 8.0, 8.5, and 8.6

• Documentation Guide for Cisco Unified Presence Release 8.6

• Installation Guide for Cisco Unified Presence Release 8.6

• Instant Messaging Compliance Guide for Cisco Unified Presence Release 8.0, 8.5, and 8.6

• Integration Guide for Cisco Unified Presence Release 8.5 and 8.6 with Microsoft Exchange

• Integration Guide for Configuring Cisco Unified Presence Release 8.6 for Interdomain Federation

• Integration Guide for Configuring Partitioned Intradomain Federation for Cisco Unified Presence 
Release 8.6 and Microsoft LCS/OCS

• Real-Time Monitoring Tool Administration Guide for Cisco Unified Presence Release 8.0, 8.5, and 
8.6

• Release Notes for Cisco Unified Presence Release 8.6(x)

• Serviceability Configuration and Maintenance Guide for Cisco Unified Presence Release 8.0, 8.5, 
and 8.6

• Upgrade Guide for Cisco Unified Presence Release 8.6

• User Guide for Cisco IP Phone Messenger Release 8.0, 8.5, and 8.6

• User Guide for Cisco Unified Presence Release 8.5 and 8.6

Deployment Guide for Cisco Unified Presence

The path for configuring meeting notification settings has changed from Application > Meeting 
Notification > Settings to Application > IP Phone Messenger > Meeting Notification Settings. For more 
information, see the Deployment Guide for Cisco Unified Presence Release 8.6 here:
http://www.cisco.com/en/US/products/ps6837/products_installation_and_configuration_guides_list.ht
ml

User Guide for Cisco Unified Presence

The path for sending broadcast messages has changed from User Options > IPPM Broadcast Messages 
to User Options > Broadcast Messages. For more information, see the User Guide for Cisco Unified 
Presence Release 8.6 here: 
http://www.cisco.com/en/US/products/ps6837/products_user_guide_list.html
40
Release Notes for Cisco Unified Presence Releases 8.6(1), 8.6(2), 8.6(3), and 8.6(3)a

http://www.cisco.com/en/US/products/ps6837/products_installation_and_configuration_guides_list.html
http://www.cisco.com/en/US/products/ps6837/products_user_guide_list.html


 

  Documentation Updates
Integration Guide for Configuring Cisco Unified Presence Release 8.6 for Interdomain Federation

The procedure “Adding a SIP Federated Domain” was updated to reflect a change in the graphic user 
interface; in the Integration Type drop-down list, the “Interdomain to OCS” option was changed to 
“Interdomain to OCS/Lync.” 

For more information, see the Integration Guide for Configuring Cisco Unified Presence Release 8.6 for 
Interdomain Federation here:
http://www.cisco.com/en/US/products/ps6837/products_installation_and_configuration_guides_list.ht
ml

Real-Time Monitoring Tool Administration Guide for Cisco Unified Presence Release 8.0, 8.5, and 8.6

The following updates were made to “Viewing and Monitoring Cisco Unified Presence and Cisco Jabber 
Communicator Summaries” section of this document:

• Cisco Jabber performance counters, CUPC Registered Users, CUPC Registered User Failures, and 
CUPC IM Messages were changed to SIP Client Registered Users, SIP Client Registered User 
Failures, SIP Client IM Messages, respectively.

• New CUP Summary performance counters were added for Cisco Unified Presence Release 8.6(3) 
and later.

For more information, see the Real-Time Monitoring Administration Guide for Cisco Unified Presence 
Release 8.0, 8.5, and 8.6 here:
http://www.cisco.com/en/US/products/ps6837/prod_maintenance_guides_list.html

Integration Guide for Configuring Cisco Unified Presence Release 8.6 with Microsoft Lync Server 
2010 Remote Call Control

References to Desk Phone Remote Call Control (RCC) were replaced with Microsoft RCC. For more 
information, see the Integration Guide for Configuring Cisco Unified Presence Release 8.6 with 
Microsoft Lync Server 2010 Remote Call Control here:
http://www.cisco.com/en/US/products/ps6837/products_installation_and_configuration_guides_list.ht
ml

Integration Guide for Configuring Partitioned Intradomain Federation for Cisco Unified Presence 
Release 8.6 and Microsoft LCS/OCS

The procedure to “Configure Remote Domain as a SIP Federated Domain” was updated to reflect a 
change in the graphic user interface; in the Integration Type drop-down list, the “Interdomain to OCS” 
option was changed to “Interdomain to OCS/Lync.”

For more information, see the Integration Guide for Configuring Partitioned Intradomain Federation for 
Cisco Unified Presence Release 8.6 and Microsoft LCS/OCS here:
http://www.cisco.com/en/US/products/ps6837/products_installation_and_configuration_guides_list.ht
ml
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Integration Note for Configuring Cisco Unified Presence Release 8.0, 8.5, and 8.6 with Microsoft OCS 
for MOC Call Control

References to Desk Phone Remote Call Control (RCC) were replaced with Microsoft RCC. For more 
information, see the Integration Note for Configuring Cisco Unified Presence Release 8.0, 8.5, and 8.6 
with Microsoft OCS for MOC Call Control here:
http://www.cisco.com/en/US/products/ps6837/products_installation_and_configuration_guides_list.ht
ml
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Obtaining Documentation and Submitting a Service Request
For information about obtaining documentation, submitting a service request, and gathering additional 
information, see the monthly What’s New in Cisco Product Documentation, which also lists all new and 
revised Cisco technical documentation, at:

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

Subscribe to the What’s New in Cisco Product Documentation as a Really Simple Syndication (RSS) feed 
and set content to be delivered directly to your desktop using a reader application. The RSS feeds are a free 
service and Cisco currently supports RSS Version 2.0.

Cisco and the Cisco Logo are trademarks of Cisco Systems, Inc. and/or its affiliates in the U.S. and other countries. A listing of Cisco's trademarks 
can be found at www.cisco.com/go/trademarks. Third party trademarks mentioned are the property of their respective owners. The use of the word 
partner does not imply a partnership relationship between Cisco and any other company. (1005R)

© 2012 Cisco Systems, Inc. All rights reserved
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